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IMPORTANT PRODUCT INFORMATION

READ THIS INFORMATION FIRST

Product: CIMPLICITY® Control, Version 2.1

IC641CTL970F Control 90-70 Programmer w/CD Documentation
IC641CTL971F Control 90-70 Programmer w/paper Documentation
IC641CTL170F Control 90-70 Programmer Logicmaster 90 upgrade
IC641CTL171F Control 90-70 Programmer Subscription upgrade
IC641CTL930D Control 90-30 Programmer w/CD Documentation
IC641CTL931D Control 90-30 Programmer w/paper Documentation
IC641CTL130D Control 90-30 Programmer Logicmaster 90 upgrade
IC641CTL990D Professional Developer Package 90-70, 90-30, SFC
IC641CTL991F Distributor Demo 10 pack
IC641CTL993F OEM Evaluation Kit – 30 day license
IC641CTL972D Upgrade to add 90-70 target
IC641CTL932D Upgrade to add 90-30 high end target
IC641CTL950A SFC language editor
IC641CTL937B Programmer Toolkit

CIMPLICITY Control Version 2.1 is an IEC 1131-3 based programming product for use with GE Fanuc
Series 90™-30 (Models 350, 351, 352 and 360) and Series 90™-70 controllers. CIMPLICITY Control runs
under Windows® 95 and Windows NT® 4.0. Built on the latest Microsoft technology, CIMPLICITY
Control is designed to adhere to industry standards including Microsoft Foundation Classes (MFC) 4.0,
ODBC, and OLE 2.0, making CIMPLICITY Control easy to use and integrate with other applications.

This release provides support for Genius® Redundancy, CPU Redundancy over Genius, Series 90-30
Profibus configuration, and modem dialing and communications for SNP.  This release also supports
Ethernet routing, SNTP configuration, and enhancements to EGD (Ethernet Global Data).
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Operational Notes

1. System Requirements

CIMPLICITY Control is compatible with Windows 95 and Windows NT 4.0.  The following versions of
Windows are recommended:
    Windows 95      Service Pack 1 (4.00.950A) or OEM Service Release 2 (4.00.950B)
    Windows NT     Service Pack 3 or later.

Your system must meet the following minimum requirements* to successfully install and run
CIMPLICITY Control for Windows 95 and Windows NT.  If free hard drive space requirements are not
maintained, CIMPLICITY Control and the underlying operating system may not operate correctly.

For Windows 95 For Windows NT

System Features Minimum Recommended Minimum Recommended

CPU Pentium/60 Pentium/133 Pentium/75 Pentium/133

RAM 16 MB 32 MB 24 MB 48 MB

Free Hard Disk Space 75 MB 75 MB 100 MB 100 MB

CD-ROM Drive Yes Yes Yes Yes

CIMPLICITY Control Version 2.1 is not compatible with Windows 98 preview or Windows 98 Beta.
If the Internet Browser desktop that comes with Internet Explorer 4.0 from Microsoft is installed and made
the default desktop, CIMPLICITY Control users may experience display problems.

2. Installation

Installing CIMPLICITY Control Version 2.1:

CIMPLICITY Control is distributed on CD-ROM. To install CIMPLICITY Control, insert the CD-ROM
into the CD-ROM drive. To view the contents of the CD-ROM, click the drive letter configured for your
CD-ROM, (typically D:\ ) from Explorer or File Manager. Double-click the icon beside setup.exe.
Review the following notes for technical information about CIMPLICITY Control installation:

• If you are upgrading your version of CIMPLICITY Control, run the Uninstall utility provided in the
CIMPLICITY Control program group to uninstall the existing version.  During the uninstall, you
will be asked if you wish to retain the current license. If you are upgrading from CIMPLICITY
Control Version 1.0, 1.1, or a beta version of 2.0, choose “No”.  If you are upgrading from
CIMPLICITY Control Version 2.0 or higher, choose “Yes” to retain your current license. If you
choose “No”, you will need to reregister your software. The Option Setup item in the Program
Group lists the phone numbers to call to obtain a new license.

• If you are installing on a computer that has dual boot into Windows 95 or Windows NT, you should
un-install and then install on one operating system, then boot into the other operating system,
repeating the procedure.

                                                          
* These requirements are for CIMPLICITY Control running as a single application. Memory requirements to run
applications simultaneously are additive. Acceptable performance is subjective and can be enhanced by employing more
RAM memory and faster processors as they become available.
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• In addition to program files, CIMPLICITY Control installs Microsoft support files in the Windows
system directory. If these files exist, they will be replaced only if CIMPLICITY Control requires a
later version than the one currently installed.

• If you attempt the installation when other Windows applications are open, you may see messages
saying the install has attempted to update a read-only file. Answer NO to the prompt asking whether
to update the file. You should exit the Install program (ALT+F3 ), close all Windows applications
and restart the CIMPLICITY Control installation program. If the message persists, reboot your
machine and repeat the process.

• CIMPLICITY Control uses the GEF_CFG.INI file that is placed in the Windows root directory to
record communications device configurations. This file is also used by CIMPLICITY HMI and
Motion, as well as other applications developed with the Host Communications Toolkit for
communicating with GE Fanuc PLCs.  If the file already exists, a prompt will display asking if the
file should be overwritten. To keep your existing file, select NO. If you overwrite the file, you may
lose configuration information used by software programs that access GE Fanuc PLCs.  The new
default file will be placed in GEF_CFG.SMP.  This file has new settings for the Serial ports that
should be edited into the existing GEF_CFG.INI file.  This can be done using either a text editor or
the Communications Configuration Utility application that is provided as part of CIMPLICITY
Control.

• If CIMPLICITY Control and CIMPLICITY PC Control are installed on the same machine, un-
installing CIMPLICITY PC Control will cause CIMPLICITY Control to lose the ability to
communicate with PLCs. Do not un-install CIMPLICITY PC Control unless you plan to remove
both packages from the machine.

3. Demo Mode

If you do not register your version of CIMPLICITY Control or do not have a licensed copy of CIMPLICITY
Control, the product will operate in demo mode. The demo mode allows you to use all features of the
product but with limited reference table sizes. You also cannot view an Equipment Folder created with a
licensed product.

Equipment Folders

• Only 90-30 or 90-70 Demo Equipment Folders can be created or opened in demo mode. They will
have a file extension name of .d3x .e7d, respectively.

• Real 90-30 or 90-70 Equipment Folders (those created with a licensed copy) cannot be accessed
when operating in demo mode.

• Demo Equipment Folders cannot be converted to or saved as real 90-30 or 90-70 Equipment
Folders. Real 90-30 or 90-70 Equipment Folders cannot be converted to or saved as Demo 90-30 or
90-70 Equipment Folders.

 Load from, Store to the PLC

• You cannot load any programs from the PLC to CIMPLICITY Control when operating in demo
mode.

• Demo Equipment Folders can be stored to the PLC.
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 Programming Restrictions

• CIMPLICITY Control demo equipment folders use the following reference table sizes:

 %I1-16  %Q1-16  %M1-16  %R1-48  %AI1-4  %AQ1-4

 %S1-128 (90-70)  %S1-32 (90-30)  %SA1-128 (90-70)  %SA1-32 (90-30)   

 %SB1-128 (90-70)  %SB1-32 (90-30)  %SC1-128 (90-70)  %SC1-32 (90-30)   

 %P1-10
(90-70 only)

 %L1-10
(90-70 only)

    

 %G1-16  %GA none  %GB none  %GC none  %GD none  %GE none

 %T none      

 Note

 When viewing references online in demo mode, you will see only the ranges available in
demo mode.

• CIMPLICITY Control Demo Equipment Folders use the following locations for auto-variable
locate:

Config: Discrete   %M1-4 Non-Discrete   %R1-5

Program: Discrete   %M9-12 Non-Discrete   %P1-5 (90-70). %R11-15 (90-30)

Local: Discrete   %M13-16 Non-Discrete   %L1-5 (90-70), %R16-20 (90-30)
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Product Compatibility
CIMPLICITY Control Version 2.1 provides programming and hardware configuration support for the Series
90-30 Model 350, 351, 352 (Version 6.61 or higher) and 360 and Series 90-70 CPUs. With restrictions
described later in this section, this release provides the same feature set as Logicmaster 90-70, Version 7.02,
and Logicmaster 90-30, Version 8.01, with the following exceptions: Single word changes on the 90-70,
mixed reference tables, and Remote Rack Configuration (BEM733). Additional features beyond
Logicmaster 90 for SFC programs include support for up to eight actions per step and the ability to program
SFC in 90-30 subroutines.

1. Hardware Compatibility

This version of CIMPLICITY Control supports the following Series 90-30 modules:

Series 90-30 CPUs IC693CPU350, IC693CPU350, IC69CPU352, IC693CPU360

Series 90-30 Discrete I/O All modules supported

Series 90-30 Analog I/O IC693ALG220, IC693ALG221, IC693ALG222,
IC693ALG223, IC693ALG390, IC693ALG391,
IC693ALG392, IC693ALG442

Communications IC693CMM311 Communication Coprocessor

IC693CMM321 Ethernet Interface

IC693CMM301 Genius Communications Module

IC693CMM302 Enhanced Genius Communications Module

Motion IC693APU300 High Speed Counter Module

IC693APU305 90-30 I/O Processor Module

IC693APU301 Motion Mate APM 1-Axis

IC693APU302 Motion Mate APM 2-Axis

IC693APU305 90-30 I/O Processor Module

IC693MCM001 Digital Servo Interface Unit

Bus Controller IC693BEM321 90-30 I/O Link Master

IC693BEM331 90-30 Genius Bus Controller

Intelligent Option Modules IC693ADC311 Alphanumeric Display Coprocessor

IC693PCM300 Programmable Coprocessor 160KB

IC693PCM301 Programmable Coprocessor 192KB

IC693PCM311 Programmable Coprocessor 640KB
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This version of CIMPLICITY Control supports the following Series 90-70 and Genius modules:

Series 90-70 I/O All modules supported

Genius devices All Phase B Genius I/O blocks are supported

Field Control I/O Field Control I/O using the Genius BIU are configured as generic I/O
on the Genius Bus

Genius Block Configuration Note (For Series 90-70)

If you have configured Genius blocks using CIMPLICITY Control Version 2 beta 3 or earlier, the
resulting H/W Configuration will not be compatible with Version 2.1. (Configurations done using beta
4 and later versions are compatible.) You will need to either re-enter the configuration using Version 2
or store the H/W Configuration to a PLC with the previous beta version and load it into a folder using
Version 2.

                                                          
* Release 4 or later 90-70 CPU firmware
** Release 3 or later 90-70 GBC firmware required

90-70 Intelligent Option Modules

IC697CMM711 Communications Coprocessor Module

IC697CMM721 GEnet MAP Carrierband (Single Slot)

IC697CMM731 GEnet MAP Broadband

IC697CMM741 Ethernet Controller Type 1

IC697CMM742 Ethernet Controller Type 2

IC697BEM763 DLAN Interface Module

IC697BEM713 Bus Transmitter Module

IC697BEM731** Genius Bus Controller Module

IC697PCM711 Peer Communications Module

IC697HSC700 High Speed Counter Module

IC697ADC701 Alpha-numeric Display Module

IC697GDC701 Graphics Display Coprocessor Module

Series 90-70 CPUs*

IC697CPU731

IC697CPU732

IC697CPU771

IC697CPU772

IC697CPU781

IC697CPU782

IC697CPU788

IC697CPU789

IC697CPU790

IC697CPM914

IC697CPM915

IC697CPM924

IC697CPM925

IC697CGR935
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2. Configuring Remote Racks with CIMPLICITY Control, Version 2.1

Version 2.1 does not support remote rack configuration (IC697BEM733). However, remote racks can be
configured for use over the Genius Bus using the following procedure:

a) Configure the Genius Bus Controller

b) Expand the Genius Bus

c) Add a Generic I/O block at the System Bus Address of the remote 90-70 I/O rack.

d) Configure the remote rack using Logicmaster 90-70.

3.  Version 1.0 and 1.1 Folder Compatibility

Folders created with Version 1.0 or Version 1.1 are forward compatible with Version 2.1.  A conversion
process is automatically invoked whenever a Version 1.0 or 1.1 folder is opened.  You will be prompted
for a new directory in which to put the old version of the folder.  Once converted to Version 2.0/2.1
format, the folder can no longer be opened with Version 1.0 or 1.1 of CIMPLICITY Control.

Folders that were created using Version 1.0 and Version 1.1 may have blocks out of synchronization
with the Neutral Form and binary representations, corrupted Comments, real-time updates in LD
showing the wrong values, and Cross-References listing incorrect rungs.  These problems were generally
introduced when CIMPLICITY Control abnormally terminated during an editing session.  The following
folder repair procedure can be used to clean-up corrupted Version 1.0 or 1.1 folders after the automatic
conversion to Version 2.1 has been completed.

Folder Repair Procedure for old VERSION 1.0 or 1.1 Folders

You can do this procedure efficiently by running two instances of the Workbench on the same
machine. One instance is used to copy from the old folder, the other to paste to the new folder.

1.  Export all variables from the old folder to an .snf file. Click on Variable Declaration Table.
Select All Visible Scopes, ALL Refs, ALL Types. Select All from the Edit Menu. Select
Variables->Export… Export variable to snf file. Edit the snf file to remove all variables that
have “_$” in them. These are internal variables that should not be imported.

2.  Create a new folder.

3.  Set up CPU Model and CPU Reference Limits in the new folder’s Hardware Configuration
(%AI, %AQ, and %R size).

4.  Set up Auto Variable Locate values to match program. Edit Resource, Program -> Auto Variable
Locate…

5.  Import Variables from the .snf file to the new folder.

6.  Create all empty Blocks in the new folder using the New Block… command.

7.  Open a block in the old folder. Select all the rungs in the block using the Edit -> Select All
command. Copy block to the clipboard. Go to the new folder. Paste contents into the
corresponding empty block of the new folder.

8.  Repeat step 7 for all blocks in the old folder.

9.  For External C Blocks, create the new block in the folder using the New Block… command and
re-import the .exe file to the folder.

10. Rebuild the new folder and verify that contents are correct.
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4.  Communications and Online Monitoring

• CIMPLICITY Control, Version 2.1, supports SNP and Ethernet (TCP/IP) communication with the
PLC. For SNP connections with 90-70 CPUs earlier than release 6.0, communication must be
disconnected in the folder before a connection can be made to the fault tables.

• When storing hardware configuration via Ethernet (where the configuration information for the
Ethernet module has changed), PLC communication will disconnect and reconnect. At this time, the
privilege level is always set at the lowest level.

• When storing hardware configuration to a 90-30 351 or 352 CPU using SNP connected to the ECSM
port on the CPU module (not the port on the power supply), an error will be reported at the end of
the store and CIMPLICITY Control will temporarily lose communications.  This happens because
the CPU resets the port at the end of the store.  To determine if the store was truly successful, you
should check the details of the stored items for failures.

• If you are online and equal with a 90-70 PLC, any changes in logic will cause that block to go to the
Not Saved state. Only the folder copy of the block has been changed and there will not be any
prompts before the change is made. If the change is intended, you can select Store Program Changes
from the right mouse button menu (or press ALT-S) to compile and send the changes to the PLC. If
the change is not intended, you must close the block without saving to abort the changes. If the PLC
is a 90-30 and the change is a single word change, it will go through the Word-for-Word change
process, allowing you to abort the change or send it directly to the PLC.

5. Software Compatibility

CIMPLICITY Control supports the creation of C program blocks and standalone C programs for both
the Series 90-70 and 90-30 PLCs. This capability requires use of the C Programmer Toolkit
(IC691SWP709 and IC691SWP719).

To use C programming on the 90-30 requires CPU Version 8.00. To use C programming on the 90-70
requires additional files for the toolkit. Call GE Fanuc PLC Technical Support for more information:

USA and Canada………………1-800-GEFANUC (1-800-433-2682)
All other Nations………………804-978-6036

6. Importing Logicmaster 90-70 Folders into CIMPLICITY Control

CIMPLICITY Control provides the capability to import Logicmaster 90-30 351 or 352 folders, version
4.0 or higher, into CIMPLICITY Control.  (Logicmaster 90-30 folders created prior to Version 4.0 must
be updated to Version 4.0 before attempting to import.)

CIMPLICITY Control provides the capability to import Logicmaster 90-70 folders, version 4.0 or
higher, into CIMPLICITY Control. (Logicmaster 90-70 folders created prior to release 4.0 must be
updated before attempting to import.)
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CIMPLICITY Control’s rules about variable, block and program names differ from those for
Logicmaster 90. To minimize the time required to prepare the Logicmaster 90 folder and reduce the
errors generated during the import operation, make sure the Logicmaster 90 block names and nicknames
conform to the following rules:

• Variable names and block names cannot contain the following characters:

 double underscore  #  +  -  @

 <  >  =  &  %

 A variable name (nickname) that contains any of the characters listed in the above table will be
considered invalid. Application folders should be reviewed for accuracy prior to import. Any invalid
variable names will be discarded, and the reference address will be used instead.

• Variable names may not be used as program or block names. All block names must also be changed
to be compliant with the naming restrictions before being imported.

• The following set of reserved words may not be used as variable, program or block names. In
addition to the reserved words, function block names are also reserved words, and may not be used
as variable, program or block names.

ACTN1, ACTN2, ACTN3 ... ACTION AND

ARRAY AT ADD

BODY BY BWAND

ANALOG_STATE BOOL BOOL_STATE

BWOR BWXOR BYTE

CONN1, CONN2, CONN3 ... CASE COMMENT

CONFIGURATION CONSTANT

DATE_AND_TIME DELAY DESCRIPTION

DINT DO DWORD

EDGE ELSE ELSIF

EN END (invalid for 90-30 only) END_ACTION

END_CASE END_CONFIGURATION END_FB_INTERFACE

END_IF END_PROGRAM END_REPEAT

END_RESOURCE END_SEL END_SIM

END_STEP END_STRUCT END_TRANSITION

END_TYPE END_VAR ENO

EXIT

FALSE FB_INTERFACE FOR

FROM FUNCTION FUNCTION_BLOCK

FUNC_INTERFACE IF INITIAL_STEP

INT INTERVAL JUMP

LANGUAGE LREAL MACRO_STEP
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MCR MOD NOT

OF ON OR

PRG_INTERFACE PRIORITY PROGRAM

PTR READ_ONLY READ_WRITE

REAL REPEAT RESOURCE

RETAIN RETURN RPTR

SEL_BRANCH SIM_BRANCH SINGLE

SINT STACK_SIZE STATIC_DATA_SIZE

STEP STRING STRUCT

SUMMARY SUB STEP1, STEP2, STEP3, ...

TRANS1, TRANS2, TRANS3, ... TASK THEN

TIME TO TRANSITION

TRUE TYPE TYPE_EXTERNAL

UDINT UINT USINT

VAR VAR_ACCESS VAR_EXTERNAL

VAR_GLOBAL VAR_INPUT VAR_IN_OUT

VAR_OUTPUT VOID WHILE

WITH WORD

Note

The Logicmaster Import function has been extensively tested. However, there may be cases where the
logic in very complex rungs does not import correctly. Error messages in the output log stating
“Dangling Horizontal”, “Illegal Rung Topology”, “Dangling Vertical”, or “Internal Error - Unable to
Draw Rung Properly” should normally appear upon a compile of the folder if any problems were
encountered. However, it is recommended that you print and review the logic after importing the
folder.

Check the GE Fanuc BBS CIMPLICITY Control area for more detailed information on importing
Logicmaster folders.

7. LD Compatibility with Logicmaster 90

CIMPLICITY Control has an option setting that facilitates sharing Ladder Logic PLC programs between
Logicmaster 90-70 and CIMPLICITY Control. This option is not necessary for the 90-30 since programs
created are compatible unless you create rungs that extend beyond 10 columns. When you use
CIMPLICITY Control in LM90 Compatibility mode for a 90-70 folder, you can store a folder to the
PLC and load it into either Logicmaster 90 or CIMPLICITY Control.

Using Logicmaster 90-70 Version 6 or later or Logicmaster 90-30 Version 4 or later, you can upload a
CIMPLICITY Control-created RLD program from the PLC into the TEMP folder (or an equipment
folder with a name that matches the program name in the PLC).  Logicmaster will indicate an EQUAL
status and be able to monitor activity in the PLC.
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Likewise, CIMPLICITY Control will be able to upload a Logicmaster 90 created RLD program from the
PLC and go ONLINE and EQUAL.  You will be able to make changes to the program and update the
program without having to STOP the PLC.

The Compatibility mode can be activated from the Workbench. With the Browser window selected, go
to the Tools menu, select Options, then select Equipment Folder.  The Equipment Folder Options dialog
box allows you to enable or disable LM90 Compatibility.  The default is Disabled.  (The setting will
automatically default to Enabled during folder import conversion of an LM90 folder to CIMPLICITY
Control).

The following notes also apply to Logicmaster 90 compatibility:

• Blocks must be less than 16K bytes.  A compile error will be issued when in LM90 Compatibility
mode if the block exceeds the limit.

• Warnings will be generated when double-wide precision instructions or Calls do not have adequate
spacing for the CIMPLICITY Control display format.

• When loading a program from the PLC that was created with Logicmaster 90, you do not have to
compile the program loaded into CIMPLICITY Control unless changes are made after the load into
CIMPLICITY Control.

8 SFC Compatibility with Logicmaster 90

Folders that contain SFC blocks created with CIMPLICITY Control are not compatible with
Logicmaster 90. You should not attempt to use Logicmaster 90 with a PLC that contains SFC blocks
created with CIMPLICITY Control. For 90-70 folders, SFC blocks will not compile (an error will be
placed in the log) if LM90 Compatibility mode is enabled.

Some simultaneous and selective constructs that were allowed in Logicmaster 90 are restricted in
CIMPLICITY Control in order to maintain IEC Compliance. You will need to edit the Logicmaster 90
folder before importing it into CIMPLICITY Control.

Logicmaster 90 connectors will be changed into directed links during import into CIMPLICITY Control.
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New Features Introduced in Version 2.1
1. Genius Redundancy - Version 2.1 introduces support for Genius Dual Bus Redundancy.  This

feature supports five types of redundant configurations: (1) Genius Dual Bus Redundancy with the
redundant bus in the same folder (GBC Pair Internal), (2) Genius Dual Bus Redundancy with the
redundant bus in another folder (GBC Pair External), (3) Genius Dual GBC Redundancy with the
redundant GBC in the same folder (GBC Pair Internal), (4) Genius Dual GBC Redundancy with the
redundant GBC in another folder (GBC Pair External), and (5) Genius Dual Bus and Dual GBC
Redundancy.

2. CPU Redundancy over Genius - The following redundant CPU models will be supported:
IC697CPU780 Redundant CPU Expandable Memory (386)
IC697CGR935 Redundant CPU 1MB Fixed Memory (486 DX4)

Two types of control strategies will be allowed in the CPU Redundant systems: (1) Genius Hot
Standby Control, and (2) Genius Dual Bus Control (not supported in CPU780).

3. Single View of a CPU Redundant system - Version 2.1 adds as part of the CPU Redundancy
support, the ability to configure an entire redundant system within a single folder.  The folder
contains the configuration for both the Primary and the Secondary systems inside of the same folder.
Modules can either be configured to be the same in each system or different.  The program logic in
both system must be identical. If either the logic is required to be different in the primary and
secondary units, then separate folders are required.

4. Ethernet Routing Configuration - Version 2.1 adds the capability of configuring a routing table
for the Type II Ethernet module in the 90-70 system.  The existing CIMPLICITY Control Name
Resolution dialog has been enhanced to include a Routing tab to allow routing to be configured for
90-70 Ethernet Modules.

5. Simple Network Time Protocol (SNTP) - Version 2.1 adds the capability of configuring SNTP for
the Type II Ethernet module in the 90-70 system.

6. Increased 90-70 Ethernet Global Data Exchanges - Version 2.1 enhances Ethernet Global Data
exchange configuration by increasing the number of exchanges that can be from 32 to 255.

7. Programmer Toolkit Extensions - Version 2.1 adds new capability to Programmer Toolkit.  The
Application Programming Interface has been enhanced to provide import of variables from a Shared
Name File (SNF) format into a specific equipment folder.  The API will support Insert, Replace, and
Delete attributes for importing variables.

8. 90-30 Profibus Configuration - Version 2.1 adds 90-30 Configuration of 2 Profibus modules:
IC693PBM100 Profibus Master Module, and IC693PBS105 Profibus Slave Module.

9. Modem Dialing and Communications for the Serial SNP Protocol - The Communications
Configuration Utility will be modified to allow the customer to enter information about the modem
they wish to use and then associate the modem definition with a device or port configuration.  When
connecting to a modem device or using modem port, the driver will automatically dial the
appropriate number, initiate the connection with the host, and read/write data to/from the PLC using
the modem connection.
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New Features Introduced in the Version 2.01 Upgrade also included in 2.1

1. Hardware Configuration for the Series 90-30 Model 350 and 360 CPUs - Version 2.01 added the
capability to configure the following 90-30 CPU models:

Release 8.10 CPU360 - IC693CPU360 Series 90-30 CPU Model 360 and
Release 8.10 CPU350 - IC693CPU350 Series 90-30 CPU Model 350

CPU 360
Identical Functionality to a Release 8.0 CPU351 except it does not have ESCM support.
Available memory for user programs is 80K.

CPU 350
Identical Functionality to CPU360 (Release 8.10) except memory available for user programs is 32K.

2. LD and SFC Programming for the Series 90-30 Model 350 and 360 CPUs.  The 350 and 360
models function identically to the 351 and 352 models for programming. Note: Floating Point is not
currently available in Model 350 and 360 CPUs
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Problems Resolved in Version 2.1
1. Loading of Logic Immediately after a Word-for-Word change has failed or been aborted no

longer causes the changed block to be empty.    The problem where a load from the PLC caused an
empty block after that block had been edited is fixed in Version 2.1.  This problem most often occurred
after a word-for-word change was aborted, but could also occur in other cases where an edit occurred
while on-line and equal and a load was performed immediately after the edit.

2. Warnings are now generated if overlapping addresses are configured using the Genius
Configuration Tool.    The problem where warnings were not generated if overlapping addresses are
created using the Genius Configuration Tool has been corrected in Version 2.1.

3. Hitting <ENTER> during Auto-Select no longer causes communications errors.  The problem
where aborting the Auto-Select by hitting <ENTER> sometimes caused “Unknown Communications
Error” messages has been fixed in Version 2.1.

4. Rungs of the following form in 90-30 folders will no longer cause CIMPLICITY Control to crash
on Load from PLC.  Rungs that logically attempt to get more than 8 deep OR branches no longer cause
CIMPLICITY Control to crash on a Load.  These rungs are illegal rungs for 90-30 LD that are not
flagged as illegal during Save and Compile.

|--| |--+----------------+----------( )
|       |                |
|--| |--+                |
|       |                |
|--| |--+                |
|       |                |
|--| |--+                |
|       |                |
|--| |--+                |
|       |                |
|--| |--+        +--| |--+
|       |        |       |
|--| |--+        +--| |--+    <<< These contacts cause problems for
|                |       |         Upload / Decompile.
|----------------+--| |--+

The decompiler will now place entries in the log file whenever rungs of this type are encountered on a
load.  These rungs still must be manually corrected in order for a load to correctly work.

5. Help has been updated in Version 2.1 to address two issues:
A better explanation of how to select more than one variable in the Variable Declaration Editor and the
index has been updated so that searching on the key word “Retentive” will find the correct topics.
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Problems Resolved in Version 2.01 also resolved in Version 2.1
1. Incorrect Logic Solution: Version 2.0 Service Pack 3 and Version 2.01 corrects a problem with logic

solution in Series 90-30s using CIMPLICITY Control. RLD programs with the following construction
will not solve correctly if stored with Version 2.0. Refer to Field Service Bulletin M-04-98-01
“CIMPLICITY Control Release 2.0 Safety Alert “ for more information.

 

 

 

 

 

 

 

 

 

 To fix this problem, install Version 2.01 and then do a Rebuild All of each CIMPLICITY Control Series
90-30 folder.

2. Update PLC Button for PID Dialog:  Using the Update PLC Button of the PID dialog box causes a
value of Zero to be written to CV.  The Update PLC Button has been disabled in CIMPLICITY Control
Version 2.0 Service Pack 2 and higher.

3. Length of Genius Global Data set incorrectly after Save: Service Pack 1 corrects a problem with the
configuration of Genius Global Data for the Series 90-70 where the length was incorrectly updated on a
Slave.

4. Intermittent Communications Errors: Intermittent communications problems, primarily occurring
during connect and store to PLC have been corrected.

 

 This location, where 3
contacts are ORed together
will not solve correctly.



Important Product Information 16
GFK-1397E

Restrictions and Open Problems

Communications

1. Time-outs may occur during a store using SNP. It is possible to lose communications intermittently
during a store operation over SNP. The problem may be experienced with very large programs, or if
running CIMPLICITY Control on a PC with little available RAM. To reduce the likelihood of this
problem occurring, limit active applications during the store, or add additional RAM. If you experience
this problem, repeat the store operation.

2. Saving folders to Novell drive. Saving folders to Novell drives that require an 8.3 format is not
supported. You must use the newer version of Novell which supports longer filename suffixes.

3. Performance tip. For best performance when using the "Store Program Changes" (ALT-S) or Word-
for-Word changes feature, you should, upon opening a folder, perform a build using the Rebuild All
command. This will allow subsequent Store Program Changes or Word-for-Word changes to occur
faster.

4. Method to expand Target Communications Window (right click on title bar) is not obvious. To
expand this window so that you can view detailed information, click the right mouse button in the title
bar of the Target Communications window.

5. Synchronizing CPU time to Host may cause Run and Stop buttons to display incorrectly for a few
seconds. To correct this problem, disconnect from the PLC and then reconnect.

6. Fault table continues to show faults after connection with PLC is terminated.  It is not possible to
clear the fault table screen when disconnected. To clear any messages logged in the fault table, you will
have to reconnect to the PLC.

7. Error message on trying to connect to wrong CPU type does not indicate if the type (70 or 30) or
the model (351, 352, etc.) is wrong .  The message only indicates that a mismatching CPU was
detected.

8. Incorrect error message.  Disconnecting the communications cable from the PLC for an extended
period of time can randomly make the message “Maximum number of users for requested port has been
reached” appear.  Exiting CIMPLICITY Control and re-entering may be required to reconnect to the
PLC.

9. Storing block and configuration information in same attempt through 9030 Serial Port #2 may
fail.  This has been observed on a 351 CPU, storing program and configuration information, and seems
to happen whether or not the new configuration information is actually different or not.

10. Cannot connect to PLC if both Genius busses in a Dual Bus/Internal Configuration are open.
Close one of the busses to perform the connect.

Hardware

1. Confusing error messages may be generated in the Ethernet Global Data dialog box. Be sure to
finish configuring Status variables in the Produced Exchanges tab before switching to the Consumed
Exchanges tab.

2. Copying and pasting a Type 2 Ethernet module from one folder to another does not copy and
paste EGD and Name Resolution entries. After performing a paste, you will need to go to the Ethernet
Global Data and Name Resolution menu items and enter the values manually.
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3. Storing HWCFG does not store Genius configuration to blocks and there is no message telling you
block configurations are not being stored. You should store the configuration from the Genius
Configuration tool (accessed by choosing Expand Bus from the right mouse button popup menu). You
will need to open the Genius Bus objects one at a time and store them.

4. Reference Addresses on Hardware Modules - drag and drop changes them. If you manually change
the reference addresses of modules to overlap, and then dragged one of the overlapping modules, the
module (on insert or drag) re-evaluates the reference address to make sure it is not conflicting. Since the
module is overlapping, it resets the address to the next available location to remove the conflicting
range.

5. 9070 CPU diagnostic/fault categories go back to defaults when CPU type is changed.  You will
need to reset these categories manually if you wish to have the settings restored.

6. Can’t set Constant Sweep higher than 2550 milliseconds.  The constant sweep time cannot be set
higher than the Watchdog Timer, which has a limit of 2550 milliseconds.

7. Storing Central Rack System or Ethernet Global Data by itself eliminates Name Resolution.
Storing the Central Rack System or  EGD configuration by itself without selecting the Name Resolution
erases the Name Resolution file from the PLC.  Always select the Name Resolution data if it has been
configured, when storing any other part of Hardware Configuration.

8. Pasting a Genius bus to the browser then double clicking on it causes Fatal System Error.

9. Configuration does not verify equal after storing a 350 or 360 configuration to a 351 / 352 CPY.
Storing a 350 or 360 configuration to a 351 CPU results in configuration not equal. Change HWCFG to
351 to fix.

10. Browser focus can get confused on Genius Dual Bus. Browser can get confused as to which bus the
primary or the starred should have focus. Leave the browser and return to fix the focus

11. APU301 allows range for EOT in follower mode. Range should be fixed at +8388607 and –833608.

12. Name Resolution and EGD files missing Type 2 Ethernet adapter name in redundancy mode. The
Type 2 Ethernet adapter should have separate names in the primary and backup. Only the last name
entered appears. This does not cause operational problems.

13. Aborting Clear of a large folder in 90-70 PLC may cause Fatal System Error on Windows 95.
After Storing to a 90-70 PLC a program of substantial size, containing name resolution and EGD, if the
PLC is cleared using the Utilities Clear Dialog, a Fatal System Error may occur when running on
Windows 95, if the clear operation is aborted prior to completion.

14. After a Load of Hardware Configuration, if the Network Address Name field is edited before the
Adapter Name has be redefined on the Ethernet Global Data dialog, it will be impossible to exit
from the dialog.  This problem can be avoided by re-entering the Adapter Name after the load before
editing any other fields in the EGD dialog.  If the Network Address Name field is accidentally edited
first then CIMPLICITY Control must be killed through the task manager.

Workbench

1. Save As function.  Premature termination of the product may occur if you attempt to do a “Save As”
function to a disk (floppy disk or hard drive) that has insufficient space.  To avoid losing work, be sure
your disk has the recommended space available.

2. Losing track of active windows from menu. You may not be able to see all the active windows in the
list displayed from the Window menu. Active windows can still be found on the screen.
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3. The Save Changes dialog only appears in the Equipment Folder when the folder is first created.
The Save Changes dialog box appears the first time you close an equipment folder after it has been
created. Operations such as Delete and Cut will not cause the Save Changes dialog to be displayed. If
you create a new folder and exit, you will be prompted to save the equipment folder. However, if you
create a new folder, insert some blocks, and then delete a block, you will not be prompted to save,
because the deletion saves the folder automatically.

4. Drag and drop in the browser will not scroll to allow drop on the part of the browser that needs to
be scrolled to be seen. To avoid this problem, use Cut and Paste instead.

5. Save As does not work to server name for networked drives. You should map the drive to a letter.

6. Importing a block from the Librarian does not include the blocks that the imported block calls.
You will need to manually import blocks that are called, or create temporary blocks with the same
names as those being called.

7. Fatal System Error may occur when opening another instance of CIMPLICITY Control with a
library file.  If you create a new library file, save it, and close the library file while leaving the
Workbench active, and then start another instance of CIMPLICITY Control and open the same library
file again, a fatal system error may occur.

8. Installation sometimes gives error message COMCTL32.DLL is locked when installing on
Windows 95.  This is because there is program that is accessing this DLL.  Close all other programs and
restart the installation.

Logicmaster Compatibility

1. Folder conversion of HEX constants. Constants programmed as HEX and displayed as HEX in
Logicmaster 90 will display in decimal format after importing or loading the folder into CIMPLICITY
Control.

2. Logicmaster 90 and CIMPLICITY Control with the same COM port. After using Logicmaster 90,
you must reboot your computer before attempting to use CIMPLICITY Control with a serial connection
to the same port that Logicmaster 90 used. If you do not reboot, you will receive an error message
stating that the requested COM port could not be opened.

3. Folders created in Versions 1.0 and 1.1 will not compile Array Move instructions.  You must adjust
the SNX, DNX, and N operands because their data type has changed from INT to UINT.

4. A type cast of a variable located in %P memory that specifies a length that extends beyond the last
variable located in %P will cause the size of the %P table to be incorrect.  Execution of a folder that
has this problem will cause the CPU to Stop/Fault with Error message of Program References exceed
those configured in PLC.   To correct this, a variable should be declared that is located at the end of the
type-casted array variable.

5. Hardware Configuration for 90-70 that contains Genius Global Data will not be able to be loaded
by LM90.  The Hardware Configuration data downloaded to the PLC when Genius Global Data is
configured is not compatible with Logicmaster 90-70 and therefore cannot be uploaded into a
Logicmaster folder.

Software Resource and Programming

1. Floating-point instructions. If the CPU is changed from a non-floating point to a floating point CPU
while the LD Editor is open, instructions requiring a floating-point CPU will not display. To view these
instructions, close and re-open the LD Editor.
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2. Parameter Edit dialog box. The Parameter Edit dialog box allows 64 characters for the description
field, but will display only 57 characters from the Header dialog box.

3. Seventy or more transitional contacts in same rung. If using 70 to 80 transition contacts in the same
rung in Accept or Normalize mode, premature termination of CIMPLICITY Control may occur which
will cause you to lose changes since your last Save.

4. Deleting all instructions in a rung does not delete the rung. To delete a rung, you must select the
rung by clicking to the left of the power rail and then delete the rung.

5. Complex 90-30 Boolean rungs failing on compile. Some 90-30 complex boolean rungs, such as the
one in the following example, fail on compile. The error message “Logic sub-path cannot enter in the
middle of another sub-path” is generated.

To work around this problem, insert an ALW_ON contact as a placeholder in the logic, as shown in the
following example.

6. Copying and pasting rungs from SFC to LD. You cannot copy and paste rungs from an SFC block to
an LD block or from the terminal LD editor in SFC to an LD block. However, you can copy from an LD
block and paste into the terminal LD editor within an SFC block.

7. Move instructions in 90-30 Equipment Folders. In a 90-30 folder, inserting a Move instruction
without enough space between it and the next Move results in data flow from output of first move to
input of second move which is not allowed in a 90-30. To avoid this, add sufficient space between Move
instructions to allow the operands to appear. To adjust the placement of the Move instruction, click once
on the Move instruction, cut the instruction, and paste it farther away from the preceding Move
instruction.

8. Footer problem when printing Use Table from a block. Printing Use Table from a block results in the
footer displaying a block name when it should not.

9. Variables that are type cast to a larger data type are not found as implicit use in Search.  You must
search directly for the reference address if it is type cast in an editor.
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10. Zoom size change does not work if Zoom is typed into LD Edit control. Click the pull-down control
for the combo box so that all the entries are displayed (75%, 100%, 150%, etc.). Now type the desired
Zoom size into the box and press ENTER with the pull down list still open.  The Zoom size should now be
properly reset.  An alternate way of setting the Zoom size is to choose Zoom from the View menu.

11. In LD Editor, data entries which are not completed are lost if you click outside the LD Edit
window.  Be sure to complete a data entry before clicking outside the LD Editor.

12. The LD Editor gives an incorrect output messages.  If you insert a named variable of local scope with
an address and then use the same name in LD logic, but you give it Configuration scope and no address,
you will receive an incorrect error message, “Variable and called block have the same name”.  If you
give a Data Init instruction a length that is too large, the error message given is “Invalid Array
Operation”.

13. PSB Bool Parameters are allowed as actual parameters.  PSB parameters of type BOOL are
incorrectly allowed to be passed as actual parameters to other PSB or External Blocks.  This should not
be allowed since the PLC does not support this.

14. Pasting a rung with a call to a “C” block into a folder where the type of the block is a PSB, does
not correct the call instruction.  If a rung with a call to “C” block from one folder is pasted into a
second folder where there is a PSB with the same name and same parameters, the rung will incorrectly
continue to show the call as CALL EXT.  To correct, delete and replace the call in the rung.

15. Use of %S32 (continuation) directly as an operand may cause programs that compile correctly to
not be able to be uploaded in the 90-30.  If the %S32 reference address is programmed on contacts
directly, a program that has been compiled and downloaded to the PLC, will fail on the decompile after
a load.  Use of %S32 directly should be avoided.  The continuation coil and continuation contacts
should be used instead.

Variables

1. Error message during Auto-Variable Location. When an error occurs using auto-variable locate, the
error message is general. The conditions are that the configured references have been exceeded or that
the range for auto-variable location has been exceeded. To view the range used for auto-variable
location, expand the Browser until the Resource is displaying in the left side of the Browser window,
then double-click Resource to open the Resource Editor. From within the Resource Editor window,
select Program from the CIMPLICITY Control menu and choose Auto Variable Locate.

2. Selecting multiple items in Variable Declaration editor. You must use the keyboard to select multiple
variables in the editor.

3. Deleting the reference address on a variable causes the scope to change to local. If you leave this
variable in local scope, you will have compile problems if the variable is used in other blocks as a
Config variable. To prevent these problems, change the scope back to Config.

4. Deleting variables at the Local Scope. If the same variable name exists at Local and Config scopes and
the local scope one is used, the Config Scope one can not be deleted from the Block Editor window.
You can, however, open the Config Scope editor and delete the variable name from there.

5. Default length of a new variable might be set to values other than 1 after inserting arrays. To
correct this, examine the length field and change it if necessary.

6. Find in Reference Table that jumps to end does not clear the bottom on the screen. Scroll the
screen to cause a refresh.
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7. Global Use Table Printout does not show overlaps in bit type Tables when 16 or 32 bit types
overlap Bools. Example Int at %G1, Bool at %G5, overlap is not shown for %G5.

8. Changing a local variable in one VarDec splitter causes all open VarDec splitters to go “not
Equal”.  Closing and reopening the editors for the other blocks will correct the problem.

9. Descriptions of Variables do not wrap in a consistent manor when displayed in LD Editor.  The
wrapping of long descriptions is based strictly on the default wrapping supplied by the Windows
underlying controls.  The convention used in LM90 is not observed.

10. Using Online Edit Dialog on Structure Variables (e.g. Timer.CV) causes CIMPLICITY Control to
crash.  Use of the Online Edit Dialog on variables that reference fields inside of a structure, such as the
CV of a timer, will cause CIMPLCITY Control to crash.  If the direct in-place edit of the online value is
used instead CIMPLCITY Control will operate correctly.

Redundancy

1. Genius Output transfer check not performed. CPU redundancy is supposed to check that all Genius
outputs and being transferred and warn if they are not. This check is not done. The check needs to be
done manually.

2. Fatal System Error closing objects in browser. In Dual Bus/ External mode if an object is inserted in
the browser, changing views or closing the object causes a Fatal System Error.

3. Equality not displayed correctly with CPU Redundancy. When using CPU redundancy in “Single
View” mode, even though both CPUs are configured identically, only the view of the Hardware
configuration for the CPU to which one is attached will show equal.  If the programmer is attached to
the Primary CPU then the view of the Secondary configuration will show “NOT EQUAL” and visa
versa.

4. Genius Bus must be expanded before proper configuration can be created for Redundant
Controller and Dual Bus.  After a GBC has been created, the bus must be expanded at least once, even
if there are no blocks to be configured in order for the redundant Bus Controllers to be properly
configured.


